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SMARTCOLOUR SOFTWARE LICENSE AGREEMENT

This is a legal agreement between you, the end user, and Sun Chemical B.V. a Netherlands 
corporation, having a principal place of business located at Leeuwenveldseweg 3, 1382 LV 
Weesp, the Netherlands (“Sun”). BY INSTALLING THIS SOFTWARE PROGRAM YOU AGREE 
TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS 
OF THIS LICENSE, DO NOT INSTALL THE SOFTWARE AND, WITHIN THIRTY (30) DAYS YOU 
MAY RETURN ANY UNINSTALLED SOFTWARE TO SUN AND, UPON SHOWING PROOF OF 
PAYMENT, REQUEST A REFUND OF FEES ACTUALLY PAID FOR THE UNUSED SOFTWARE.  
In addition, in order to access the full functionality of this Software, you will be required to agree 
to be bound by the terms of the SmartColour Database Access Agreement prior to logging into 
the SmartColour database (the “SmartColour Database”) via Internet access or other access as 
provided by Sun.

Grant of License. Sun grants you a nonexclusive and nontransferable license, without rights 
of sublicense, to use the object code of Sun’s SmartColour Software (including to connect to 
and access via the Internet, or other means as determined by Sun, the relevant SmartColour 
Database) and the accompanying documentation, if any, (collectively, the “Software”) for your 
individual use as provided in this Agreement. Sun and its licensors, if any, reserve all rights not 
expressly granted to you.

Authorized Use. This license allows you to install this software solely on computers to be used 
by the individual identified by the Login Credentials (as that term is defined in the SmartColour 
Database Access Agreement) for whom you purchase access to the SmartColour Database. You 
agree to prevent and protect the contents of the Software from unauthorized disclosure or use.

Restrictions.  You may not (i) sell, rent, lease, timeshare, license, sublicense, distribute or 
otherwise transfer in whole or in part the Software to another party; (ii) provide, disclose, divulge 
or make available to, or permit use of the Software in whole or in part by, any third party without 
Sun’s prior written consent; or (iii) modify or create derivative works based upon the Software. 
Except to the extent expressly permitted by applicable law, and to the extent that Sun is not 
permitted by that applicable law to exclude or limit the following rights, you may not decompile, 
disassemble, reverse engineer, or otherwise attempt to derive source code from the Software, in 
whole or in part.

Copyright. The Software is owned by Sun (and its licensors, if any) and is protected by United 
States copyright laws and international treaty provisions. As between the parties hereto, Sun 
retains all right, title and interest in and to the Software (other than the license expressly granted 
hereby). You are licensing the Software in accordance with the terms of this agreement and 
are not acquiring any claim or right of ownership in the Software or any intellectual property 
contained therein. Therefore, you must treat the Software like any other copyrighted material, 
except that you may make one copy of the Software solely for backup purposes. Such copy 
must include Sun’s copyright and other proprietary notices and you may not remove any titles, 
trademarks or trade names, copyright notices, legends, or other proprietary markings on the 
Software. You may not copy the written materials accompanying the Software. 

Term. The term of the license granted under this Agreement shall commence upon the 
acceptance of this Agreement as provided herein, and shall continue unless terminated in 
accordance with this Agreement. You may terminate this license at any time by destroying the 
Software and the permitted backup copy of each. This license automatically terminates if you 
fail to comply with the terms and conditions of this Agreement or of the SmartColour Database 
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Access Agreement. You agree that, upon such termination for any reason, you will permanently 
delete from any hardware and storage device, all copies of the Software, and records and 
information obtained from the SmartColour Database, and destroy or return to Sun the original 
Software; together with any other material you have received from Sun in connection with the 
Software.  You agree to provide Sun with written certification by an authorized officer, or by 
the licensee where an individual has licensed the software, that such Software, and all records 
and information obtained from the SmartColour Database, have been removed and deleted as 
required under this paragraph.

Support.  Sun shall have no obligation to provide technical support for the Software, including 
without limitation, end-user support.  If Sun chooses to provide any technical support, at its sole 
discretion, such technical support will be provided as is, and subject to the disclaimer below.

LIMITED WARRANTY AND DISCLAIMER. Sun hereby warrants that the Software, as delivered 
and if properly installed by you in accordance with the terms of this Agreement, will be capable 
of operating substantially in conformance with the product documentation provided with the 
Software for a period of 90 days following the date you purchased the Software. Your sole and 
exclusive remedy for breach of the foregoing warranty is set forth in the Customer Remedy 
paragraph below. EXCEPT FOR THE LIMITED WARRANTY ABOVE, AND TO THE MAXIMUM 
EXTENT PERMITTED BY APPLICABLE LAW, SUN AND ITS SUPPLIERS PROVIDE THE 
SOFTWARE AND SUPPORT SERVICES (IF ANY) AS IS AND WITH ALL FAULTS, AND HEREBY 
DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, WHETHER EXPRESS, IMPLIED 
OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY (IF ANY) IMPLIED WARRANTIES, 
DUTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
RELIABILITY OR AVAILABILITY, ACCURACY OR COMPLETENESS OF RESPONSES, RESULTS, 
WORKMANLIKE EFFORT, LACK OF VIRUSES, AND LACK OF NEGLIGENCE, ALL WITH 
REGARD TO THE SOFTWARE, AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT 
OR OTHER SERVICES, INFORMATION, SOFTWARE, AND RELATED CONTENT THROUGH THE 
SOFTWARE OR OTHERWISE ARISING OUT OF THE USE OF THE SOFTWARE.  ALSO, THERE 
IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, 
CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH REGARD TO 
THE SOFTWARE AND SUN DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED 
IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF 
THE SOFTWARE OR THE CONNECTIVITY TO THE SMARTCOLOUR DATABASE WILL BE 
UNINTERRUPTED OR ERROR-FREE OR THAT DEFECTS IN THE SOFTWARE WILL OR CAN 
BE CORRECTED.  ANY IMPLIED WARRANTIES FOUND TO APPLY TO THIS TRANSACTION 
ARE HEREBY EXPRESSLY LIMITED TO A PERIOD OF 90 DAYS FOLLOWING THE DATE YOU 
PURCHASED THE SOFTWARE. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY 
TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE 
OTHER RIGHTS, WHICH VARY ACCORDING TO JURISDICTION.

LIMITED LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN 
NO EVENT SHALL SUN OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, 
CONSEQUENTIAL, EXEMPLARY OR OTHER DAMAGES, INCLUDING, WITHOUT LIMITATION, 
LOST PROFITS, LOST BUSINESS OR LOST DATA, RELATING TO THE SOFTWARE, THE 
PROVISION OF OR FAILURE TO PROVIDE SUPPORT OR OTHER SERVICES, INFORMATION, 
SOFTWARE, AND RELATED CONTENT THROUGH THE SOFTWARE OR OTHERWISE ARISING 
OUT OF THE USE OF OR FAILURE TO USE THE SOFTWARE, WHETHER OR NOT DUE 
TO SUN’S NEGLIGENCE, AND SUN WILL NOT BE LIABLE FOR ANY DIRECT DAMAGES, 
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EXCEPT AS EXPRESSLY PROVIDED UNDER THE CUSTOMER REMEDY SECTION BELOW. 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY 
TO YOU.

Customer Remedy. Sun’s entire liability and your exclusive remedy for any breach of the 
limited warranty set forth above shall be, at Sun’s options, either (i) return of the price paid 
for the Software, upon which time you will destroy all copies of the Software, cease using the 
SmartColour Database, delete all copies of the database records and information obtained from 
the SmartColour Database, and destroy or return to Sun the original Software, together with any 
other material you have received from Sun in connection with the Software, and provide written 
certification as provided under the paragraph entitled “Term”, or (ii) repair or replacement of 
the Software.  The limited warranty is void if failure of the Software has resulted from accident, 
abuse, or misapplication, or if you modify the Software. Any replacement Software will be 
warranted for the remainder of the original warranty period or 30 days, whichever is longer. 

Export Controls. The Software and the underlying information and technology may not be 
downloaded or otherwise exported or re-exported (i) into (or to a national or resident of) Cuba, 
Libya, North Korea, Iran, Sudan, Syria or any other country to which the U.S. has embargoed 
goods; or (ii) to anyone on the U.S. Treasury Department’s list of Specially Designated Nationals 
or the U.S. Commerce Department’s Table of Deny Orders. By installing or using the Software, 
you are agreeing to the foregoing and you represent and warrant that you are not located in, 
under the control of, or a national or resident of any such country or on any such list.

U.S. Government End Users. The Software is a “commercial item,” as that term is defined at 
48 C.F.R. 2.101 (Oct. 1995), consisting of “commercial computer software” and “commercial 
computer software documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept. 1995). 
Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all 
U.S. Government End Users acquire only those rights in the Software that are provided by this 
Agreement.

General. This Agreement will be construed under the laws of England and the parties hereby 
submit to the exclusive jurisdiction of the English Courts. The parties agree that the United 
Nations Convention on the International Sale of Goods shall not apply. Performance of any 
obligation required by a party hereunder may be waived only by a written waiver signed by the 
other party, which waiver shall be effective only with respect to the specific obligation described 
therein. If any provision of this Agreement shall be held by a court of competent jurisdiction to 
be contrary to law, that provision will be enforced to the maximum extent permissible, and the 
remaining provisions of this Agreement will remain in full force and effect.

This Agreement, along with the SmartColour Database Access Agreement, constitutes the 
entire agreement between the parties and supersedes all prior agreements, understanding, 
negotiations, and discussions of the parties. All the terms and provisions of this Agreement will 
be binding upon and inure to the benefit of the parties, their successors and assigns, except that 
you may not assign or otherwise transfer this Agreement or the license granted herein without 
Sun’s prior written consent, and any attempt by you to do so without that consent will be void 
and will be deemed a breach of this Agreement. Modifications to this Agreement may be made 
from time to time in the SmartColour Database Access Agreement, and such modifications shall 
control this Agreement.  In the event of a conflict between the terms of this Agreement and the 
terms of the SmartColour Database Access Agreement, the terms of the SmartColour Database 
Access Agreement shall control.
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Introduction
SmartColour™ iVue is an innovative color management system that allows 
everyone in the packaging design workflow to view predicted spot color at 
every stage of the process. Not paint-on-plastic-to-give-you-a-rough-idea color, 
but real color. With real ink. On real substrates. Using real print processes. The 
same color whether it’s on the screen. On a proof. Or on a shelf. Anywhere in the 
world.
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SmartColour iVue System Requirements
Hardware

PowerPC•	  G4 or G5, or Intel processor 

2 GB of RAM•	

64 MB of video RAM•	

Suggested Monitor

23-inch Apple Cinema HD Display•	

Eizo CE240W LCD Monitor•	

Operating System

Mac OS 10.4 or higher

Software

Adobe Photoshop CS3•	

•	 GretagMacbeth ProfileMaker Pro Version 5

Suggested Printers

•	 Canon PIXMA Pro9000 Printer

•	 Epson Stylus Photo R2400

Suggested Paper

Canon Photo Paper Pro•	

Network

Access to the Internet

Spectrophotometer

• X-Rite/GretagMacbeth EyeOne-IO with monitor attachment



Setting Up

9

Setting up for SmartColour iVue
This section includes the following procedures:

Installing SmartColour iVue on Mac OS •	 X

Setting Color Picker to SmartColou•	 r

Toggling•	  Color Pickers

Calibrating•	  and Profiling the Device

Setting Photoshop Color Setting•	 s
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Installing SmartColour iVue on Mac OS X
This section describes how to install iVue on Mac OS X.

To install iVue on Mac OS X:

Quit Adobe Photoshop.1.	

Insert the iVue Installation CD.2.	

Follow the prompts and proceed with the installation.3.	
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Setting your Color Picker to SmartColour
You set your Color Picker to SmartColour so you can use SmartColour colors in 
Adobe Photoshop. As an alternative, you can use the procedure that follows to 
toggle between Color Pickers.

To set the Color Picker to SmartColour:

In Photoshop, choose 1.	 Photoshop>Preferences>General.

Select the Color Picker pop-up menu, and choose 2.	 SmartColour. 

Select 3.	 OK to close the Preferences panel.

Toggling Color Pickers

You can use the following procedure to switch back and forth between the 
SmartColour Picker and the color picker you were using previously.

To toggle the Color Picker:

In Photoshop, choose 1.	 Filter>SmartColour>Toggle Color Picker...
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Calibrating and Profiling the Device
This guide includes the recommended parameters for device profiling. For 
detailed instructions on how to calibrate and profile your device, refer to the user 
guide provided with your profiling software. 

Profiling a Monitor

Note: While profiling the monitor, you should avoid all ambient lighting.

To profile a monitor:

Clean the monitor surface.1.	

Place the measurement device at the center of the monitor.2.	

Open the preferences for your profiling software. 3.	

Select Expert mode if it is available.4.	

Define the following parameters:5.	

Profiling Chart Set to a minimum of 99 color patches

Profile White Point 5000K

Profile Gamma 2.2

Target White 
Luminance

150 cd/m2

Target Black 
Luminance

0.5 cd/m2

Apply the Profile in the Display settings of the System Preferences.6.	

Store the profile in 7.	 HD>Library>ColorSync>ICC Profiles.
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Profiling a Printer

Note about ICC profile versions: Be aware that ICC Version 2 does not support 
the perceptual intent correctly and it can be broken by an embedded profile 
in the workflow. ICC version 4 is more accurate than the version 2, however, 
SmartColour iVue does not fully support ICC version 4. This is not an issue as 
long as colorimetric is the rendering intent. When creating a profile, select ICC 
version 4 if available and if the rendering intent is colorimetric.

Note: Avoid all ambient lighting while performing the measurement.

To profile a printer:

Check the ink level is sufficient.1.	

Perform a nozzle check and clean the print heads if necessary.2.	

Perform a print head alignment.3.	

Set the Profiling chart to a minimum of 918 patches. (1728 patches is 4.	
preferred.)

Print a test chart for the printer with color management off and no color 5.	
correction in the print dialog option. 

Wait 30 to 60 minutes before measuring the printed chart.6.	

Select the largest profile size (or the largest profile lookup table) available 7.	
for profile creation.

Set the viewing light source to D50.8.	

Store the profile in 9.	 HD>Library>ColorSync>ICC Profiles.
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Setting Photoshop Color Settings
To set the color settings:

In Photoshop, choose 1.	 Edit> Color Settings.

Define the following parameters in the Color Settings panel:2.	

Working Spaces

RGB

CMYK 
 

Gray

Choose your Monitor ICC Profile.

Ensure the CMYK profile you choose has a paper 
white point similar to the paper white point of the 
SmartColour library you choose. For example, U.S. 
Web Coated (SWOP) v2.

Gray Gamma 2.2

Color Management 
Policies

RGB

CMYK

Gray

 

Off

Off

Off

Conversion Options

Engine

Intent

Use Black Point 
Compensation

Use Dither

Apple CMM

Absolute Colorimetric

Unchecked 

Unchecked

Advanced Controls

Desaturate Monitor 
Colors

Blend RGB Colors 
Using Gamma

Unchecked 

Unchecked

Select 3.	 OK.
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Using SmartColour iVue
This section describes the following procedures:

Logging in and Loading a SmartColour iVue Librar•	 y

Changing Librarie•	 s

Adjusting Spot Channel Dot Gai•	 n

Applying SmartColour Spot Colors to Spot Channel•	 s

Previewing Design Fil•	 es

Setting up Gamut Checkin•	 g

Printing Design Fil•	 es
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Logging in and Loading a SmartColour iVue Library
You need to log in to the SmartColour iVue server before you load a SmartColour 
library into Adobe Photoshop. You will need to choose an Owner Group and a 
SmartColour library. 

If you have a new file open, the library will be loaded and you will be able 
to assign spot colors from the new library. If the file contains spot colors,  
SmartColour colors will automatically be assigned to the spot colors in your 
design document.

Note: The connection to the server will automatically time-out after 30 minutes.

To log in to SmartColour iVue and load a SmartColour library:

In  Photoshop, open a design file with spot colors.1.	

Choose 2.	 Filter>SmartColour>Choose Library.

Type your 3.	 Customer ID.

Type your 4.	 Password.

Select 5.	 Log in.
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Photoshop connects to the server and the Choose SmartColour Library 
panel displays.

Choose an 6.	 Owner Group.

Select a library.7.	

Select 8.	 OK.
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If this is a new file, the colors will be downloaded and you will be able •	
to use the colors from the SmartColour library in your new design file.

If your design file contains spot colors, the colors will be downloaded •	
and SmartColour iVue will suggest new colors to replace the spot 
colors in your design file. The SmartColour Channels Recolored panel  
will display.

     

(Optional) If you don’t want to accept a suggested replacement color, 9.	
disable the checkbox. You will need to manually edit the spot color 
channel in Photoshop using the procedure, Applying SmartColour Spot 
Colors to Spot Channels.

Select 10.	 OK to accept the replacement color(s).

The SmartColour library colors are applied to the spot colors in the file.
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Changing Libraries
Use the following procedure if a SmartColour library is already loaded and you 
want to change to a different SmartColour library.

To change libraries:

Choose 1.	 Filter>SmartColour>Choose Library. 

        The Choose SmartColour Library panel displays.

 

Choose an 2.	 Owner Group.

Select the new library.3.	
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Select 4.	 OK.

The new colors are loaded, and the SmartColour Channels Recolored panel 
displays.

Select 5.	 OK.

Replacement colors are applied to the image.

When you assign spot colors, you will choose from the colors in the 
library you loaded.
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Adjusting Spot Channel Dot Gain
You can adjust the spot channel dot gain by using the Document Settings option 
in iVue SmartColour.

To adjust the spot channel dot gain:

In Photoshop, open a design file.1.	

 Choose 2.	 Filter>SmartColour>Document Settings

The Document Settings panel displays.

To change the Min Dot, Max Dot, or Dot Gain, drag the cursor over the 3.	
number you wish to change. The pointer cursor will change to a text 
cursor, then you can type in the new number. 

(Optional) If you want to simulate printing spot colors before process 4.	
colors, enable Simulate spot colors printed first.

Press 5.	 OK. 
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Applying SmartColour Spot Colors to Spot Channels
Note: Ensure you have set the Color Picker to SmartColour in your Photoshop 
Preferences before you apply SmartColour spot colors to spot channels.

To apply SmartColour spot colors to spot channels:

Open the design file in Photoshop.1.	

Select the 2.	 Window menu and verify the Channels option is enabled. 

�Double click on the channel that you wish to apply color to from the 3.	
SmartColour library.  

       The Spot Channel Options panel displays.

Click on the color swatch. 	4.	

Note: If you haven’t loaded a SmartColour library yet, the following 
prompt is displayed. You will need to connect to the server, choose and 
load a SmartColour library.
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If you have loaded a SmartColour library already, the 
‘SmartColour Picker  box displays with information (Lab values, 
Color match quality, and ∆E value) regarding the library’s closest 
match.

�(Optional) If you don’t want to accept the suggested color, 5.	
perform the following steps:

Sort the colors. •	
By default, the colors are sorted by hue. Select the radio 
button in the upper right-hand corner of the SmartColour 
Picker to sort by Delta E. (This will sort the colors by the 
closest match.)

Choose a new color.•	

Select 6.	 OK. 

Select 7.	 OK again to close the Spot Channel Options panel.

If you want to you apply another SmartColour library color, repeat 8.	
Steps 3 to 7.
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Previewing Design Files
Once the colors from the SmartColour library have been applied, you can 
preview your design.

In the preview window, you can choose to use a whitepoint from a profile in the 
“Simulate Media White” list, or choose to use the whitepoint of the SmartColour 
media that the library’s inks are intended for. 

Note: If you choose a profile from the “Simulate Media White” list, it will change 
the printer output.

To preview a design file:

	Choose 1.	 Filter>SmartColour>Preview.

The colors are downloaded and the SmartColour Preview panel displays.

(Optional) Under 2.	 Simulate Media White, choose a media to simulate from 
the Media pop-up menu.



Using SmartColour

25

Setting up Gamut Checking
You set up gamut checking so you can view the areas that will be out of the 
printer’s gamut when you print.  It does not affect printer output.

To setup gamut checking:

	Choose 1.	 Filter>SmartColour>Preview.

The colors are downloaded and the SmartColour Preview panel displays.

Configure the following parameters in the 2.	 SmartColour Preview panel.

Enable •	 Show Profile Gamut Warning.

In the •	 Gamut pop-up menu, choose a printer profile to check 
warnings against.

The areas that are out of gamut are highlighted in the color that has 
been configured in your Photoshop Preferences.
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Printing Design Files
Once the colors from the SmartColour library have been applied, you can print 
your design. 

Note: The print profile should be created and loaded into the ColorSync library 
before Adobe Photoshop is launched. 

To print a design file:

	Choose 1.	 Filter>SmartColour>Preview.

The colors are downloaded and the SmartColour Preview panel displays.

(Optional) Under 2.	 Simulate Media White, choose a media to simulate from 
the Media pop-up menu. 
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Choose a print profile.3.	

(Optional) Change the scale of the printed image by entering a number 4.	
between 1 and 100 in the Scale field.

Select5.	  Print.

The Print panel displays.

Choose your print options. 6.	

Select the correct media type.•	

Turn off color management or color correction.•	

Select7.	  OK.
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spot channels
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